Blender Q blender

Lernvideos & step by step Checklisten: Tastenkirzel interaktiv:
http://media.kswillisau.ch/in/blender/index. html http://media.kswillisau.ch/in/blender/tasten.htmi

Tipp: QR-Code Reader aus der SBB-App verwenden.

allgemeine Tipps
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Tastenbefehle gelten fur das Fenster, tber dem der Cursor liegt

Riickgangig mit CTRL + Z
Speichern CTRL + @ und Bestatigen mit ENTER

Ansicht wird mit den Zahlentasten des Numblocks gesteuert (vgl. Tastenkirzel)
Ansicht zoomen mit dem Mausrad

Ansicht verschieben: SHIFT bzw. CTRL + Mausrad

Ansicht frei rotieren: MMB| gedriickt (Mausrad)

Auswahl zentrieren: Numblock D (Punkt)

zwischen Object- und Edit-Mode umschalten: TAB-Taste

LMB| und |RMB stehen fiir linker bzw. rechter Mousebutton

MMB | steht fir das Mausrad (mittlerer Mausbutton)

LMB platziert den 3D-Cursor

RMB selektiert Ecken (vertices), Kanten (edges) oder Flachen (faces), je nach Modus
SHIFT + RMB| erweitert die Selektion

Modellieren

Vorbereitung Hintergrundbilder

Standard Projekt starten: CTRL + N > OK

ev. Tool Shelf einblenden: T

ev. Properties Shelf einblenden: N B

3D-Cursor in Ursprung setzen: SHIFT+C| B

in die orthogonale Perspektive wechseln: Numblock @

Frontansicht einstellen: Numblock (1

im Properties Shelf unten:

e Option Background Images aktivieren

e AddImage > Axis: Front > mit v aufklappen > Open > alien_front_V2.png
e mit Y-Eigenschaft Bild nach oben schieben, damit Unterkante auf der Nulllinie liegt
Seitenansicht einstellen: Numblock

im Properties Shelf unten:

e AddImage > Axis: Right > mit v aufklappen > Open > alien_rechts_V2.png
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e mit Y-Eigenschatft Bild nach oben schieben, damit Unterkante auf der Nulllinie liegt

2. Hauptkorper extrudieren

Datei: fimalienStart.blend

o 3D-Cursor in Ursprung setzen: |[SHIFT+C|

neues Objekt einfugen: + A > Mesh > Circle

im Tool Shelf links unten die Anzahl Vertices auf 8 reduzieren
in den Edit-Modus wechseln: TAB-Taste

ev. Frontansicht einstellen: Numblock 1]

O 0O O0O0

nach unten extrudieren
o Segmente nach unten in Z-Richtung extrudieren: E > Z und mit der Maus positionieren

> mit fixieren
0 Segmente skalieren: S/ und mit Maus skalieren > mit LMB fixieren
0 unterer Abschluss:

e beim Skalieren auf null setzten: |S > Numblock

e Doppelte Ecken entfernen: Tool Shelf: Remove Dou-

bles

e Kontrolle im Infopannel: 7 vertices removed

o0 madglichst wenige Segmente erstellen (vgl. Abbildung).

nach oben Extrudieren

o in der Wireframe Ansicht [Z die obersten 8 Punkte selektie-

ren:

. und mit linker Maustaste Rahmen aufziehen

e Kontrolle in der Infozeile: Ve:8-?7?

mit Z in die Solid-Darstellung zurlickwechseln

o wiederholt extrudieren und skalieren: E > |Z > > >
LMB

o oberer Abschluss: S > 0 > Remove Doubles

@]

3. erster Arm extrudieren
Datei: flmalienBody.blend (bei Verwendung dieser Datei Backgroundimages neu laden)
o0 im Objektmode Korper des Alien im Properties Shelf N rechts um die Z-Achse 22.5°
rotieren, damit die Arme einfacher extrudiert werden kénnen
o mit in den Edit-Modus wechseln
o mit Numblock 3 in die Seitenansicht wechseln
o ev. Verteilung der drei Punktringe optimieren:
Wireframe Ansicht:
alles deselektieren:
mit B/ und umranden alle 8 Punkte eines Ringes selektieren
mit G| und Z| verschieden
ev. mit S| skalieren
o Standort von vier Punkten je einzeln optimieren:
o mit RMB| selektieren
e mit G und|Y| verschieben
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o in den face select mode wechseln (CTRL + TAB)
o drei (ibereinander liegende Flachen mit RMB und SHIFT +
RMB auswahlen (vgl. Abbildung)
o mit Numblock 1] in die Frontansicht wechseln
0 Arm extrudieren:
e mit E/> X in X-Richtung Extrudieren
e mit|S skalieren und
e mit G verschieben
o0 drei Finger einzeln extrudieren:
e nur eine Flache selektieren
e wiederholt mit [El > X und |S| sowie (G| zu einem Finger aus-
formen

4. zweiter Arm kopieren

Datei: flmalienArm.blend (bei Verwendung dieser Datei Backgroundimages neu laden)

o mit @ in den Edit-Mode wechseln

o mit B| alle Ecken des linken Arms auswéahlen

o mit SHIFT + D Arm duplizieren und mit den Verschiebemodus abbrechen

Auswahl mit + M spiegeln an Achse X >

o mit /G und Y| die Kopie korrekt platzieren

o mit Numblock 4 Modell leicht nach links rotieren

0 Modell 6ffnen, d.h. 3 Flachen entfernen: im Flachenmodus einzeln selektieren und mit
> Faces entfernen

o im Kantenmodus: zu verbindende Kanten paarweise mit RMB| und |[SHIFT + RMB| se-
lektieren und mit F zu Flachen modifizieren

5. Augen einfugen

Datei: fimalienArm2.blend (bei Verwendung dieser Datei Backgroundimages neu laden)

o in Objektmodus wechseln:

o Mesh hinzufiigen: + A > Cube

o der Wiurfel in Teilflachen unterteilen: Properties Editor > Add Modifier > Subdivision-
Modyfier > view 1 | render 2 und zum Schluss Apply|

mit S| skalieren und G| platzieren

mit SHIFT + D| das Auge duplizieren und mit G| platzieren

mit RMB und SHIFT + |RMB] die beiden Augen und den Kérper selektieren

die drei ausgewahlten Objekte vereinigen +

mit A alles auswéhlen

im Tool Shelf Remove Doubles

mit + N die Ausrichtung neu berechnen

O O0OO0OO0OO0OO0OOo
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Rendern

1. erstes Rendern
Datei: flmalienModell.blend

erstes Bild

o im Properties-Shelf N die Hintergrundbilder entfernen

O mit @ die Kamerasicht rendern (berechnen)

o mit ESC die Bildanzeige verlassen

o mit CTRL + @ +Q in die Quad-Ansicht wechseln

o Positionen mit|Gl und R optimieren und mit F12| erneut rendern

o mit + +|Q kann die Quadansicht verlassen werden

Materialen

o0 im Object-Mode Alienkdrper auswahlen

o im Properties Editor unter Material mit + ein neues Material erstellen

o Material mit ,Alien“ benennen

o Diffuse-Farbe (Eigenfarbe) auswahlen

0 ev. Specular-Farbe (Glanzfarbe) anpassen und Intensitat reduzieren

o in den Editor-Mode wechseln B

o eine Kante des Auges selektieren und mit CTRL + L alle verbundenen Kanten selektie-
ren

o mit RMB eine Kante des zweiten Auges dazu selektieren und mit CTRL + L alle ver-

bunden Kanten selektieren

0 im Properties Editor unter Material mit + ein neues Material erstellen und mit ,Augen*
benennen.

0 erwunschte Farben einstellen und mit Assign der Auswahl zuweisen

2. erste Szene
Datei: filmalienSubdividedBlue.blend

Zusatzobjekte Sandboden einfligen

0 mit SHIFT| + @ ein neues Mesh vom Typ Grid einfligen: Size: 20
o Edit-Mode: Subdivide aus Tool-Shelf T: # of Cuts: 1; Smoothness: 2.0, Fractal: 20
0 neues Material generieren, Diffuse- und Specular-Farbe anpassen

Licht

o0 Im Object-Mode die Lampe auswahlen und im Properties Editor auf Typ ,Sun“ andern

o Mit @ Position der Lampe optimieren und mit @ Einfallsrichtung des Sonnenlichts defi-
nieren

Welt
o Im Properties-Editor im Reiter World passende Einstellung wahlen:
e Optionen Blend-Sky und Real-sky aktivieren
e Horizont- und Zenit-Farbe einstellen
e ev. weitere Einstellungen wie Nebel (Mist) oder Sterne (Stars) vornehmen
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Kamera

o im Object-Mode mit CTRL| + + Q| in die Quad-Ansicht wechseln
o Position der Kamera mit (G| z.B. in der Top-Ansicht optimieren

0 in der Kameraansicht mit G| die Ausrichtung der Kamera optimieren

Armaturen: Skelett

1. zentrales Skelett erstellen

Datei: flmalienModellSubdividedBlue.blend

o im Objekt-Mode Frontansicht mit Numblock

3D-Cursor mit LMB| auf der Hohe der Schultern platzieren
mit SHIFT + A > Armature > Single Bone einfiigen

in den Edit-Mode wechseln: TAB
der Tip (Spitze) des Bones ist selektiert und mit 'S und |Z entlang der
Z-Achse verkleinern

mit [E| bis zur Spitze der Antenne sieben weitere Bones extrudieren
(s. Abbildung)

o Bones im Outliner-Fenster oben rechts sinnvoll benennen, jeweils mit

bestatigen

2. Armskelett erstellen

Dat ei: flmalienSkelettArm.blend

o die Root (Basis) des ersten Knochens selektieren und
mit E| Schulterknochen links (nach rechts) extrudieren

0 weiteres Extrudieren mit E:

O 0O 0O

o

e Oberarm
e Unterarm
e Hand

o extrudieren eines einfachen Fingers:
e aus dem Handknochen das erste Fingerglied des Mittelfingers extrudieren
e der neu erstellte Knochen in der Mitte selektieren

mit +|P| > Disconnect Bone

e Knochen mdglichst genau ins erste Fingerglied einpassen

mit E zwei weitere Fingerglieder des Mittelfingers extrudieren

o die beiden weiteren Finger analog extrudieren

o alle Bones korrekt benennen

o alle Knochen mit A selektieren und mit + N > Y| die Rolls der Knochen neu be-
rechnen

Mesh und Skelett verbinden: , parenten”
0 mit TAB|in den Objektmodus wechseln
mit RMB| Alienkérper und mit [SHIFT + RMB| Armature auswéhlen,

dann CTRL + P > With Automatic Weights auswahlen
mit CTRL + in den Pose-Mode wechseln und erste Bewegung testen

mit ALT) + @ die einzelnen Bones Bewegungen zurticksetzen

O O 0O
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3. Steuerung der Finger (optional)
Datei: flmalienSkelettFinger.blend

(0]

o
(0}

o O @] O O 00O o

O o0oo0oo0oo

im Edit-Mode die Root (Basis) des ersten Fingergliedes selektieren und mit +
> Cursor to Selected den 3D-Cursor platzieren

mit SHIFT| + A einen neuen Knochen einfigen (Verbindungsknochen)

den Tip (Kopf) des dritten Fingerglieds selektieren und den 3D-Cursor mit +S >
Cursor to selected platzieren

den Tip (Kopf) des neu erzeugten Verbindungsknochens mit + S| > Selction to
Cursor auf den 3D-Cursor platzieren

diesen Knochen mit ,ctrIMittel.I* benennen

mit unverandertem 3D-Cursor mit E einen Steuerknochen extrudieren

diesen Knochen mit ,targetMittel.I“ benennen

nun mit|CTRL + TAB| in den Pose-Mode wechseln

mit RMB| den soeben erstellten Targetknochen und mit SHIFT + RMB] das letzte Fin-
gerglied auswahlen

mit + || > To Active Bone einen IK Constraint einfiigen

(Ein Inverse Kinematic Constraint schrankt die Bewegungsfreiheit ein.)

im Properties Editor unter Bone Constraints die Chain Length auf 3 beschrénken

im Edit-Mode zuerst ,ctrIMittel.|* auswahlen und dann mit|SHIFT + RMB| den Handkno-
chen dazu selektieren

die beiden Knochen mit + P> Keep Offset verbinden (,parenten®)

die zwei weiteren Finger analog mit Kontroll- und Targetknochen versehen

alle Bones korrekt benennen

fur alle Kontroll- und Targetbones im Properties Editor die Option ,Deform” deaktivieren
alle Knochen mit A selektieren und mit + N > Y| die Rolls der Knochen neu be-
rechnen

4. Skelett komplettieren
Datei: flmalienSkelettKomplett.blend

(0]

O O0OO0O0OOo

5.

Basis (Root) des linken Schulterknochens selektieren

3D-Cursor mit +S > Cursor to Selected platzieren

in der Fusszeile des 3D-Fensters den Pivot-Punkt auf den 3D-Cursor setzen
nur d|e Knochen des linken Arms selektieren

mit SHIFT + I dup I|2|eren und m|t C den Verschiebemodus abbrechen
TR

Auswahl mit +|M| an Achse X spiegeln. Mit ENTER| bestatigen.

Mesh und Skelett abschliessend , parenten”

Datei: filmalien.blend

o
o

o

Alien-Mesh auswahlen und mit + P| > Clear Parent Elternbeziehung auflésen
Beim Alien im Edit-Mode mit Al alle Flachen selektieren und mit + N alle Norma-
len neu berechnen

zuriick im Object-Mode Alien mit auswahlen und mit SHIFT + RMB| Armatur dazu
selektieren

dann + P/ > With Automatic Weights auswahlen

Kontrolle im Outliner oben rechts, ob Armature Elternelement zum Mesh (Alien) ist.
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6. Verformungen kontrollieren

Datei: flmalien00.blend

o im Properties Editor im Reiter Armature > Display > Stick auswéhlen

im Object-Modus die Armature selektieren

mit CTRL + TAB in den Pose-Mode wechseln

mit R oder S einen Bone rotieren oder skalieren und beobachten, wie das Alien-Mesh
verformt wird.

O OO

Achtung: Rotationen und Skalierungen immer unmittelbar riickgangig machen: + @
oder + S. Bei mehreren Knochen zuerst mit A alle selektieren.

mit [RMB Alien auswahlen

mit CTRL| + TAB in den Weight-Paint-Mode wechseln

gewulnschten Bone auswahlen

Werkzeug Brush aus dem Tool-Shelf verwenden:
Weight auf O bzw. 1 einstellen B -
Radius anpassen im Tools-shelf oder mit F und LMB
Strength anpassen

O 00O

Achtung: Gewichtungen auch auf der Rickseite anpassen: CTRL + Numblock
o Vorgehen fur jeden Knochen wiederholen

Animieren

1. Posen und Animationen

Datei: flmalienWeighted.blend

o Stellen Sie unten im Timeline-Fenster die Anzeige auf DopeSheet um

andern Sie im Header-Menu (unten) auf Action-Editor

Verschieben Sie die Animationszeit auf Bild 1: SCHIFT| + &

Selektieren Sie die Armature und wechseln Sie mit CTRL + TAB in den Pose-Mode

Positionieren Sie die beiden Arme locker herunterhangend.

Selektieren Sie die beiden Armknochen im linken Arm

fligen Sie einen Keyframe mit | > Rotation ein

verandern Sie die Animationszeit mit SHIFT| + @ auf Bild 51

rotieren Sie die Armknochen so, dass der Arm erhoben ist

fligen Sie erneut fir beide Armknochen einen Keyframe mit | > Rotation ein

springen Sie mit SHIFT + €| auf Bild 1

starten und beenden Sie die Animation jeweils mit ALT + A

stellen Sie weitere Animationszeiten ein und realisieren Sie Bewegungen wie z.B.:

e winken

e Kopf drehen

e wackeln mit der Antenne

o Duplizieren und verschieben Sie die einzelnen Rauten im Dope-Sheet mit den Ublichen
Befehlen SHIFT + D bzw. G.

o fehlerhafte Keyframes kénnen im Dope-Sheet oder mit + ||l geléscht werden

OO0 O0OO0OO0OO0O0OO0OO0OO0O OO0
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2. Actions erstellen
Datei: filmalienPosed.blend

(0}

3.

Posen als Aktion speichern:

e unten im Header vom Action-Editor den Namen ,ArmatureAction ,, durch ,Winken*
ersetzen

e Button F neben dem Namen aktivieren

e Kontrolle, ob der Button H dunkelgrau hinterlegt ist

e dann mit X neben dem Namen aktuelle Aktionseinstellungen l6schen

mit + neﬂ leere Aktion erstellen, Posen mit Keyframes fixieren und unter einem Namen

speichern

weitere Posen analog erstellen

alle gespeicherten Aktionen kénnen mit dem Doppelpfeil links des Aktionsnamens

durchsucht werden

Mischen von Aktionen

Datei: flmalienActions.blend

o
(0}
o

Ziehen Sie an der Ecke des Action-Editors ein zuséatzliches Fenster auf

andern Sie die Anzeige des untersten Fensters auf NLA-Editor

Waéhlen Sie im Action-Editor eine Aktion aus. Diese erscheint nun automatisch im NLA-
Editor.

Im NLA-Editor muss die gewtinschte Aktion durch Klick auf die Schneeflocke zur Bear-
beitung frei geschaltet werden.

Nun kénnen Aktionen wie in einem Videoschnittprogramm bearbeitet werden:

e verschieben mit G

skalieren mit S

kopieren mit SHIFT + D

an der Cursorposition schneiden: Y

weitere Funktionen finden sich im Properties-Panel N:

z.B. repeat

4. Actions rendern
Datei: flmalienActions.blend

(0}
(0}

Kameraansicht optimieren: Quad-Ansicht mit CTRL| + +Q

im Properties-Shelf im Reiter Render Einstellungen vornehmen:
e Start und Endframe festlegen

File Format auf ein Filmformat umstellen: z.B. H.264

ev. Presets MPEG4 verwenden

ev. Frame Step anpassen (+ Rechenaufwand)

ev. Anti Aliasing Reduzieren (+x Rechenaufwand)

ev. Dimensions mit Presets anpassen (x Rechenaufwand)
Animation rendern: CTRL + F12
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Blender in one day

5. Animierte Szene Rendern

Datei: flmalienActionsRender.blend

o0 Objekte aus anderen Dateien importieren: File > Append
z.B. flalienSzene.blend

o Es offnet sich die Dateistruktur und im Unterordner Mesh finden sich die verschiedenen
Objekte.

o Es kdnnen auch Kameras und Lampen importiert werden: entsprechend Unterordner
Camera oder Lamp wéahlen

o Render-Einstellungen anpassen z.B. in der Quad-Ansicht CTRL + +/Q

o Animation rendern: +

Animierte Kamerafahrt

o Mit + A Objekt vom Typ Curve > Path einfiigen

o Die Form des Paths bearbeiten und ev. mit markiertem Endpunkt und +

zusatzliche Punkte einfigen

Kamera markieren und anschliessend Markierung um den Pfad mit SHIFT + RMB| er-

weitern.

Beziehung erstellen: +|P > Follow Path

Path selektieren und im Reiter Object-Data die Option Follow deaktivieren

Die Kamera ist ev. verschoben: mit +|0 auf Pfad Origin positionieren

Kamera auf Objekt fixieren:

e Kamera auswahlen und im Reiter Object Constraints mit add einen neuen Cons-
traint vom Typ Track to einfigen

e Zielobjekt einstellen

e Ausrichtung der Kamera mit den Optionen to und up einstellen.

o mit + Al die Animation starten und uberpriifen

0 beim Path ev. die Eigenschaft Frames erhdhen

o Ev. Geschwindigkeit der Kamera im Graph-Editor Fenster + F6) detailliert
steuern:
e Nurbs-Path > Evaluation-Time auswahlen: im Eigenschaften-Fenster rechts den

Generator-Modifier mit Klick auf x 16schen

e mit +LMB neue Punkte einfiigen und bearbeiten, v.a. auch die Tangenten
« die Achsen lassen sich mit CTRL| + MMB einzeln skalieren
e ev. Modifier vom Typ Cycles ergdnzen

@]

O 0 O0Oo
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Extrudieren

verwendete Befehle

Mesh einflgen: + @

Wechsel zwischen Object- und Edit-Mode:

Extrudieren:

Extrudieren abbrechen:

einschranken auf Z-Achse:

Skalieren:

Skalieren auf 0: Numblock 0

Selektieren: (rechte Maustaste)

aktuelle Selektion erweitern: SHIFT + RMB

iiberzéhlige Knoten entfernen: im Tool-Shelf T: remove doubles
Riickgangig mit +

Ansicht wird mit den Zahlentasten des Numblocks gesteuert (vgl. Tastenkirzel)
Ansicht zoomen mit dem Mausrad

Ansicht verschieben: SHIFT bzw. CTRL+ MMB (Mausrad)

Ansicht frei rotieren: gedricktes Mausrad

Speichern +/S und Bestatigen mit

OO0OO0O0OO0O0O0OO0OO0O0O0OD0OO0OO0OO0OO0OO
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